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Preface

Oracle Identity Manager Connector Guide for PeopleSoft User Management provides
information about integrating Oracle Identity Manager with PeopleSoft User
Management.

Note: This is a transitional release following Oracle's acquisition of
Thor Technologies. Some parts of the product and documentation still
refer to the original Thor company name and Xellerate product name
and will be rebranded in future releases.

This guide is intended for users who want to deploy the Oracle Identity Manager
connector for PeopleSoft User Management.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For more information, visit the Oracle Accessibility
Program Web site at

http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, some screen readers may not always read a line of text
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle does not own or control. Oracle neither evaluates nor makes
any representations regarding the accessibility of these Web sites.



TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services
within the United States of America 24 hours a day, seven days a week. For TTY
support, call 800.446.2398.

Related Documents

For more information, refer to the following documents in the Oracle Identity Manager
documentation set:

»  Oracle Identity Manager Release Notes

»  Oracle Identity Manager Installation and Upgrade Guide for JBoss

»  Oracle Identity Manager Installation and Upgrade Guide for WebLogic
»  Oracle Identity Manager Installation and Upgrade Guide for WebSphere
»  Oracle Identity Manager Administrative and User Console Guide

»  Oracle Identity Manager Administrative and User Console Customization Guide
»  Oracle Identity Manager Design Console Guide

»  Oracle Identity Manager Tools Reference Guide

»  Oracle Identity Manager Audit Report Developer Guide

»  Oracle Identity Manager Best Practices Guide

»  Oracle Identity Manager Connector Framework Guide

s Connector guides for various third-party applications

Documentation Updates

Oracle is committed to delivering the best and most recent information available. For
information about updates to the Oracle Identity Manager 9.0.0 connector
documentation set, visit Oracle Technology Network at

http://www.oracle.com/technology/documentation/index.html

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.

vi
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About the Connector

Oracle Identity Manager automates access rights management, security, and
provisioning of IT resources. Oracle Identity Manager connectors are used to integrate
Oracle Identity Manager with third-party applications. The connector for PeopleSoft
User Management is used to integrate Oracle Identity Manager with PeopleSoft User
Management.

Note: Oracle Identity Manager connectors were referred to as
resource adapters prior to the acquisition of Thor Technologies by
Oracle.

This chapter contains the following sections:
= Supported Functionality
= Reconciliation Module

»  Files and Directories That Comprise the Connector

Supported Functionality

The following table describes the functions that are available with this connector.

Functionality Type Description

Add User Provisioning Creates a user account

Password Updated Provisioning Updates the password of a user

User Description Updated ~ Provisioning Updates the description of a user

Multi Language Code Provisioning Updates the multilanguage code of a user
Updated

Primary Email Address Provisioning Updates the e-mail address of a user
Updated

Primary Email Type Provisioning Updates the e-mail address type of a user
Updated

Language Code Updated Provisioning Updates the language code of a user
Currency Code Updated Provisioning Updates the currency code of a user
Employee Id Updated Provisioning Updates the employee ID of a user
Primary Permission List Provisioning Updates the Primary Permission list of a
Updated user
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Reconciliation Module

Functionality Type Description

Process Profile Permission ~ Provisioning Updates the Process Profile Permission
List Updated list of a user

Navigator Home Permission Provisioning Updates the Navigator Home Permission
List Updated list of a user

Row Security Permission Provisioning Updates the Row Security Permission list
List Updated of a user

User Id Alias Updated Provisioning Updates the user ID alias of a user

Add RoleName Provisioning Adds a role name to a user account
Delete RoleName Provisioning Deletes a role name from a user account
Add EmailAddress Provisioning Adds an e-mail address to a user account
Delete EmailAddress Provisioning Deletes the e-mail address of a user
Enables a User Provisioning Enables a PeopleSoft user

Disables a User Provisioning Disables a PeopleSoft user

Reconcile Lookup Field Reconciliation Reconciles the lookup fields

Reconcile User Data Reconciliation Trusted mode: Reconciles user data from

PeopleSoft User Management to Oracle

Identity Manager. A corresponding user
is created in Oracle Identity Manager. If
the user already exists in Oracle Identity
Manager, then this user is updated.

Nontrusted mode: Reconciles user data
from PeopleSoft User Management to
Oracle Identity Manager. A user is not
created in Oracle Identity Manager.

Reconciliation Module

This section describes the elements that the reconciliation module extracts from the
target system to construct reconciliation event records.

Reconciliation can be divided into the following topics:

= Lookup Fields Reconciliation

s User Reconciliation

Lookup Fields Reconciliation

Lookup fields reconciliation involves reconciling the following lookup fields:

= LanguageCode
= Employeeld

s CurrencyCode
s PermissionList
s  EmailType

m  UserRoles
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Reconciliation Module

User Reconciliation

User reconciliation involves reconciling the following fields of PeopleSoft User
Management:

s Userld

s UserDescription

= Employeeld

s PrimaryEmailld

= PrimaryEmailType

= MultiLanguageCode

= LanguageCD

s CurrencyCode

s Alias

= RowSecurityPermission

s ProcessProfilePermission

= NavigatorHomePagePermission

= PrimaryPermission

= EmailAddress

= EmailType

= Role

The connector supports user data reconciliation in two different ways.
»  Bulk Reconciliation (First-Time Reconciliation)

This type of reconciliation is performed to reconcile existing users using a flat file.
The flat file is generated using an Application Engine program written in
PeopleCode. This program is run using PeoplSoft Application Designer.

= Change-Based Reconciliation

This type of reconciliation is performed using PeopleSoft Application Messaging
Architecture. In change-based reconciliation, data for any newly created or
updated user is reconciled at predefined intervals.

The changed-based reconciliation mechanism reconciles user data by using the
following components:

= A PeopleCode trigger, which generates an XML message containing updated
information

= Attribute definitions (usually resource parameters) to be synchronized
= A Web service that acts as a passive listener for XML feeds from PeopleSoft

=  An XML file, USR_MGMT_MSG.xml, that defines the schema of the XML message
received from PeopleSoft.

The steps involved in the synchronization process from PeopleSoft to Oracle Identity
Manager are as follows:

1. User information is updated in PeopleSoft, activating a PeopleCode trigger.
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Files and Directories That Comprise the Connector

2. The PeopleCode trigger generates an XML message containing the updated user
information and sends it to the listener for the PeopleSoft User Management
connector.

3. The listener forwards the XML message to the PeopleSoft User Management
connector.

4. The PeopleSoft User Management connector uses HI'TP to send the XML message
to Oracle Identity Manager.

5. Oracle Identity Manager receives the XML message and creates a reconciliation
event.

Figure 1-1 illustrates the synchronization process from PeopleSoft User Management
Reconciliation to Oracle Identity Manager.

Figure 1-1 Synchronization Process from PeopleSoft User Management Reconciliation
to Oracle Identity Manager

‘ PeopleSoft
Oracle Identity Manager R;cton
s PeopleSoft
PeopleSoft . Application

- PeopleSoft
e Reconciliation o PeopleSoft ; PeopleSoft
Reconciliation ; . Reconciliation ) Messaging
~¢— XML over HTTP —]
Process Engine v Connector Listener (People Code 8.x
Trigger)

Configuration
File

Files and Directories That Comprise the Connector

The files and directories that comprise this connector are compressed in the following
ZIP file on the installation media:

Enterprise Applications\PeopleSoft Enterprise Applications\PeopleSoft User
Management Rev 1.0.0.zip

These files and directories are listed in the following table.

File Name with Path Description
xml \PSFTBaseConnector .xml This XML file contains the following components of the
connector:

s IT resource type

s [T resource

= Resource object

= Process definition
= Process tasks

= Adapters

s Custom Process Form
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Files and Directories That Comprise the Connector

File Name with Path

Description

xml\PSFTBaseXellerateUser.xml

This XML file contains the configuration for the Xellerate
User. You must import this file only if you plan to use the
connector in trusted source reconciliation mode.

lib\JavaTask\PSFTBaseProvisioning.jar

This JAR file contains the class files that are required for
provisioning.

lib\ScheduleTask\PSFTBaseReconciliation.jar

This JAR file contains the class files that are required for
reconciliation.

lib\peopleSoftUserMgmt .war

This WAR file contains the PeopleSoft listener Web
application. It contains all the classes and configuration
files required for the Web application to run.

PeopleSoft\test\psft-xel-test.vbs

This VBScript file is used to test the PeopleSoft listener
Web service by creating XML feeds similar to the ones
created by PeopleSoft User Management Reconciliation.

PeopleSoft\test\pingRequest.xml
PeopleSoft\test\pingResponse.xml
PeopleSoft\test\publishRequest.xml
PeopleSoft\test\publishResponse.xml

These XML files are required by the psft-xel-test.vbs
file for communicating with the PeopleSoft listener Web
service using XML over HTTP.

PeopleSoft\test\USR_MGMT MSG.xml

This XML file is used by the psft-xel-test. vbs file to
define the schema of the XML message that is received
from PeopleSoft.

The following files in the 1ib\ThirdParty
directory:

. csv.jar

n peoplesoft.jar
s pshttp.jar

n psjoa.jar

s pstools.properties

The csv. jar file is the list of utility files, which are used
to read Comma Seprated values. The peoplesoft. jar
file is the set of class files.

The following files in the base directory:
n AddEmp. txt

u CurrencyCode. txt

. EmailType. txt

u EmployeeId. txt

n LanguageCode. txt

s PermissionList.txt

n Populate. txt

u UserRoles. txt

These files contain the PeopleCode for the steps that you
define for the Application Engine program. Refer to
"Creating the Application Engine Program" on page 2-7 for
details.

The following file in the base directory:
UserMgmtCBRecon. txt

This file contain the PeopleCode for the SavePostChange
event while performing the "Publish the Message"
procedure.

docs\B31131_01.pdf
docs\html

These are PDF and HTML versions of this guide, which
provides instructions on deploying the connector.

The "Step 2: Copying the Connector Files and External Code" section on page 2-1
provides instructions to copy these files into the required directories.

About the Connector
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Deploying the Connector

loying the connector involves the following steps:

Step 1: Verifying Deployment Requirements

Step 2: Copying the Connector Files and External Code
Step 3: Configuring the Target System

Step 4: Configuring the PeopleSoft Listener

Step 5: Importing the Connector Files

Step 6: Configuring Reconciliation

Step 7: Compiling Adapters

Step 1: Verifying Deployment Requirements

The following table lists the deployment requirements for the connector.
Item Requirement

Oracle Identity Manager Oracle Identity Manager release 8.5.3 or later
Target systems PSFIBase

Target systems host platforms Microsoft Windows

Step 2: Copying the Connector Files and External Code

The

connector files to be copied and the directories to which you must copy them are

given in the following table.

Note: The directory paths given in the first column of this table
correspond to the location of the connector files in the following ZIP
file on the installation media:

Enterprise Applications\PeopleSoft Enterprise Applications\
PeopleSoft User Management Rev 1.0.0.zip

Refer to "Files and Directories That Comprise the Connector" on
page 1-4 for more information about these files.
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Step 3: Configuring the Target System

File in the Installation Media Directory

Destination Directory

xml\PSFTBaseConnector .xml

xellerate_home\xlclient)\

You may have to create the x1client directory in the
Oracle Identity Manager installation directory.

xml\PSFTBaseXellerateUser.xml

xellerate_home\xlclient\

lib\JavaTasks\PSFTBaseProvisioning.jar

xellerate home\xellerate\JavaTasks

lib\ScheduleTask\PSFTBaseReconciliation.jar

xellerate_home\xellerate\ScheduleTask

The following files in the 1ib\ThirdParty directory:

n csv.jar

s peoplesoft.jar
n pshttp.jar

s psjoa.jar

] pstools.properties

xellerate_home\xellerate\ThirdParty

The following files in the base directory:
n AddEmp . txt

n CurrencyCode. txt

. EmailType. txt

] EmployeeId. txt

n LanguageCode. txt

s PermissionList.txt

n Populate. txt

s UserRoles.txt

] UserMgmtCBRecon. txt

xellerate_home\xellerate\scripts\

You may have to create the scripts directory in the
Oracle Identity Manager installation directory.

docs\B31131_01.pdf
docs\html

xellerate _home\xellerate\docs

Step 3: Configuring the Target System

Configuring the target system involves performing the following procedures:

s Creating the APIs for the Component Interface

»  Creating the Java Template for the Component Interface

s Creating the Application Engine Program

Creating and Publishing the Message

Perform the following procedures to create and publish the message:

s Create the Message Channel

s Create the Message
s Publish the Message

Create the Message Channel

To create the message channel, perform the following steps:

1. Click Start, Programs, and Application Designer. The PeopleSoft Application
Designer window is displayed.
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Step 3: Configuring the Target System

Select New from the File menu. The New Definition dialog box is displayed.
Select Message Channel, and then click OK.

Save the new message channel as USR_MGMT_MSGCH.

a k& ® N

Select Definition Properties from the File menu. The Message Channel Properties
dialog box is displayed.

6. Select the Run option, and then select Archive Messages.

Create the Message
After creating the message channel, create the message as follows:

1. In the PeopleSoft Application Designer, select New from the File menu. The New
Definition dialog box is displayed.

2. Select Message from the list.

3. Select Definition Properties from the File menu. The Message Properties dialog
box is displayed.

4. Select the Use tab.

5. On the Use tab, select the USR_MGMT_MSGCH message channel and the version of
the message that you just created.

6. Select Active to make the message an active message.
7. Save the message as USR_MGMT_MSG.

8. Right-click VERSION_1 and select the Insert Child Record property. A new
window Insert Record will appear, to choose the records to be added to the
Message.

9. Enter PSOPRDEFEN in the Name field, and click the Insert button. The
PSOPRDEEN record will be added to the message.

10. Repeat steps 8 to 9 for PSUSEREMAIL, PSOPRALIAS, and PSROLEUSER_VW
records.

11. Clicking on each record will display all the fields pertaining to that record in the
adjacent window on the right. Select only those fields which are required in the
XML Message. Refer USR_MGMT_MSG . xm1 to find out the required fields.

12. Save the message again.

Publish the Message

To publish the message, perform the following steps:
1. Select Open from the File menu. The Open Definition dialog box is displayed.

2. Select Component from the Definition list, enter USERMAINT in the Name
Selection Criteria field, and then press Enter. All component names starting with
the text USERMAINT are displayed.

3. Select USERMAINT from the list, and then click Open. The details of the
USERMAINT component are displayed.

4. Click the Structure tab, right-click USERMAINT, and then select View
PeopleCode. The PeopleCode for the USERMAINT component is displayed.

5. Select the SavePostChange event from the list in the upper-left corner of the
window. The PeopleCode for this event is displayed.

Deploying the Connector 2-3



Step 3: Configuring the Target System

8.

Copy the code given from the following file immediately after the import
definitions in the PeopleCode for the SavePostChange event:

xellerate _home\xellerate\Scripts\UserMgmtCBRecon. txt

Add the following function call at the end of the PeopleCode for the
SavePostChange event:

If Len(%CompIntfcName) = 0 Then
Local string &OPID;
&0PID = PSOPRDEFN.OPRID;
GENERATEUSR (&0PID) ;
End-If;

Select Save from the File menu to save the changes to the USERMAINT component.

Configuring PeopleSoft Enterprise Portal

PeopleSoft Enterprise Portal provides a single gateway to critical information in
PeopleSoft User Management Reconciliation and other applications and systems. In
order to use the PeopleSoft User Management Reconciliation connector, you must
perform the following tasks:

Configure the Gateway
Create the USR_MGMT_NODE Remote Node
Secure the USR_MGMT_MSG_CH Message Channel

Configure the Gateway

To configure the gateway, you have to set up the gateway, local node, remote node in
the PORTAL. To do this, perform the following steps:

1.

Open a Web browser and enter the URL for PeopleSoft Enterprise Portal. The URL
for PeopleSoft Enterprise Portal is in the following format:

http://servername/psp/Databasename/?cmd=1login
For example:
http://psftserver.acme.com/TestDB/?cmd=1login

Expand PeopleTools, Integration Broker, and then Gateways in the list on the
portal page. The Gateway component details are displayed.

Enter LOCAL in the Integration Gateway ID, and then click Search. The LOCAL
gateway is a default gateway that is created when you install PeopleSoft
Enterprise Portal.

Ensure that the IP Address in the URL of the PeopleSoft listening connector is the
IP address of the Web server where PeopleSoft is installed. The URL of the
PeopleSoft listening connector is in the following format:

http://computer_name/PSIGW/PeopleSoftListeningConnector
For example:
http://172.19.151.53/PSIGW/PeopleSoftListeningConnector

Click Load Gateway Connectors to load all target connectors that are registered
with the LOCAL gateway.

Click Save.

2-4 Oracle Identity Manager Connector Guide for PeopleSoft User Management



Step 3: Configuring the Target System

Note: Local gateway will be already defined when we install the
People Soft. You need to provide the url and load the Target
connectors.

Create the USR_MGMT_NODE Remote Node
To create the UST_MGMT_NODE remote node, perform the following steps:

1.

10.
11.
12.

Click PeopleTools, Integration Broker, Node Definitions on the left hand menu
in PeopleSoft Enterprise Portal.

Click the Add a New Value tab. On the Add a New Value tab, enter the Node
Name as USR_MGMT_NODE and click on Add button. The Node Definition page is
displayed.

Enter description in the Description field. Make this node a remote node by
deselecting the Local Node check box and selecting the Active Node check box.

Click the Connectors tab, and enter the following information:
Gateway ID: LOCAL

Connector ID: PSFT81TARGET

Perform a lookup.

In the Properties section, and enter the following information:
Property ID: PSFT81TARGET

Property Name: URL

Required value: Enter the URL of the PeopleSoft servlet that will receive the XML
message. This URL is in the following format:

http://computer_name:port/peopleSoftUserMgmt/do/peopleSoftAct
ion

For example:

http://172.21.109.75:8080/peopleSoftUserMgmt/do/peopleSoftAct
ion

Click Save.

Click the Transactions tab, and then click Add Transaction. The Add Transaction
page is displayed.

Enter the following details to define the new transaction:
Transaction Type: Outbound Asynchronous

Request Message: USR_MGMT_MSG

Request Message Version: VERSION_1

Click Add.

To keep the status as active, select Active.

Click Save to save the changes.

Secure the USR_MGMT_MSG_CH Message Channel

After finishing the node configuration, you must provide security for the
USR_MGMT_MSG_CH message channel. To do this:

Deploying the Connector 2-5



Step 3: Configuring the Target System

Navigate to PeopleTools, Security, Permission & Roles, and Permission Lists.
Select AEAE1000. The AEAE1000 permission list is displayed.

Select the Message Monitor Tab, and then click the + * Button to add a channel
name.

Enter the channel name as USR_MGMT_MSG_ CH.
Select Full Access from the list, and Click Save.

Navigate to PeopleTools, Integartion Broker, Monitor, Monitor Message, and
then Channel Status to check the status of the message channel.

Check if the status of the USR_MGMT_MSG_CH message channel is running. If the
status is Pause, then click the Run button to activate it.

Creating the APIs for the Component Interface

To create the APIs for the Component interface:

1.

Open the Application Designer by clicking Start and then selecting Programs,
Peoplesoft8.9hcm, and Application Designer. The Application Designer window
is displayed.

In the Application Designer window, select Open from the File menu. The Open
Definition dialog box is displayed.

In the Open Definition dialog box, select Component Interface from the
Definition list.

Enter USER_PROFILE in the Name field, and then press Enter.

All the Component interfaces with names that start with USER_PROFILE are
displayed in the Open Definition dialog box.

Select the USER_PROFILE entry, and then click Open.

Click Yes in the message that is displayed. The properties of the USER_PROFILE
Component interface are displayed.

In the window for the USER_PROFILE Component interface, select PeopleSoft
APIs from the Build menu. The Build PeopleSoft API Bindings dialog box is
displayed.

In the Java Classes area of the Build PeopleSoft API Bindings dialog box, select the
Build check box.

In the Target Directory field, specify the path of the directory in which you want
the APIs to be created and then click OK.

Creating the Java Template for the Component Interface

To create the Java template:

1.

On the right pane of the window for the USER_PROFILE Component interface,
right-click USER_PROFILE.

Select Generate Java Template from the shortcut menu. A message showing the
name and path of the Java template is displayed.

Click OK to close the message.
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Step 3: Configuring the Target System

Creating the Application Engine Program

The reconciliation process requires the Application Engine program to be run in 2-Tier
mode. You can run the application designer in this mode by selecting Connection
Type as the database on the PeopleSoft sign-on screen. In addition, the database client
must also be installed on the server used for accessing the application designer.

To create the Application Engine Program, perform the following steps:

1.

il

© ® N o a &

11.
12.
13.

Click Start, Programs, Peoplesoft8.9hcm, and then Application Designer. The
Application Designer window is displayed.

Select New from the File menu. The New Definition dialog box is displayed.

Select Application Engine from the Definition list. The App Engine Program
window is displayed.

Select Action from the Insert menu.

Add a step named currency.

In the App Engine Program window, select Action from the Insert menu.
From the list, select PeopleCode.

Click Save from the File menu to save the PeopleCode action.

Double-click the PeopleCode action.

. Copy the code from the CurrencyCode. txt file, which is in the

xellerate _home\xellerate\scripts directory. The code has a default value
for the output reconciliation file where the reconciled data is stored.

Change the value to an appropriate location on the PeopleSoft server.
Save the PeopleCode action.
Repeat Steps 5 through 11 to create the steps listed in the following table.

Step Name File Containing the PeopleCode

currency CurrencyCode. txt

language LanguageCode. txt

emplid EmployeeId. txt

userrole UserRoles. txt

permiss PermissionList.txt

EmailType EmailType. txt

14. Save the Application Engine Program with the name BLKPRCS_USER.

Running the Application Engine Program
To run the Application Engine Program, perform the following steps:

1.
2
3.

Open the application designer in 2-Tier mode.
Provide the correct connection type, user ID, and password.

Click the File menu, and open the application engine program, which you just
created.

Click the RUN PROGRAM control that exists on the bar just below the Menu bar,
on the extreme right. The code written on the peoplecode action will get executed.
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The comma separated files will get created on the specified location mentioned in the
code.

Step 4: Configuring the PeopleSoft Listener

This section describes how to configure the listener for the PeopleSoft User
Management connector. In the following instructions, xellerate home refers to the
local Oracle Identity Manager Server installation directory.

To configure the PeopleSoft Listener:

1.

Copy the peopleSoftUserMgmt . war file from the lib directory into a temporary
directory.

Enter the following command to extract the WAR file in the temporary directory:

jar -xvf peopleSoftUserMgmt.war

Edit the attributemap.properties file in the top-level directory. This file
contains the mapping between the PeopleSoft attributes that the XML feed will
contain and the corresponding Oracle Identity Manager attribute. You must
modify this file on the basis of the local configuration. Apply the following
guidelines when you modify this file:

a. Obtain the XML schema of the PeopleSoft XML feed from the PeopleSoft
administrator.

b. Obtain the xpath of all the PeopleSoft attributes. This is the complete path of
the attribute from the root node in the XML file.

c. Modify the attributemap.properties file by entering name-value pairs.
Here, name is the Oracle Identity Manager field name and value is the
PeopleSoft attribute xpath from the XML feed.

Edit the deployment . properties file in the top-level directory. This file
contains the message property, which corresponds to the name of the XML
message from the PeopleSoft feed. The default value of this attribute is
USR_MGMT_MSG. Obtain the correct value for this attribute from the PeopleSoft
administrator.

Edit the x1session.properties file in the top-level directory. This file contains
the following Oracle Identity Manager connection parameters.

= ObjectName: This is the name of the resource object in Oracle Identity
Manager against which the reconciliation event is created. The default value is
PSFTBase. However, for nontrusted reconciliation, you can change it to any
other resource object.

= Username: This is the user name for logging in to Oracle Identity Manager.
The default value is xelsysadm.

= Password: This is the password for logging in to Oracle Identity Manager. The
default value is xelsysadm.

Edit the x1client.properties file in the top-level directory. This file contains
the following system properties that enable an API client to communicate with
Oracle Identity Manager:

s xLhomedir: This property identifies the Oracle Identity Manager Client
directory. Typically, the Oracle Identity Manager client directory is
xellerate_home\xlclient.
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java.security.policy: This property identifies the path of the security policy
file. Typically, this file is located in the
xellerate_home\xlclient\config\ directory.

java.security.auth.login.config: This property identifies the path of the
authentication configuration file. Typically, this file is located in the
xellerate_home\xlclient\config\ directory.

Each application server uses a different authentication configuration file:
IBM WebSphere Application Server: authws . conf

BEA WebLogic Application Server: authwl . conf

JBoss Application Server: auth.conf

java.naming.provider.url: This property identifies the JNP URL of the
application server. This value is in the
<Discovery><CoreServer><java.naming.provider.url> tag of the
xellerate _home\xlclient\config\xlconfig.xml file.

Edit the following properties in the configureReconciliation.properties
file from the top-level directory:

reconciliationMode: This property can accept one of two possible values:

— If reconciliation is to be performed in a trusted mode, then set the
reconciliationMode property to trusted.

— If reconciliation is to be performed in a nontrusted mode, then set the
reconciliationMode property to nontrusted.

Serverdateformat: This property contains the date format that is used for
the PeopleSoft server. You can select one of the following date formats:

-  dd-mmm-vyy
—  ddmmyy
—  yyddmm
—  yymmdd

xellerateOrganization: This property contains the name of the
organization. The default value of this parameter is Xellerate Users. The
value that you assign to this property must exist in Oracle Identity Manager.

nullDate: This property contains the default value for a date field. The
value is 2200/01/01 00:00:00 PST. This value is used if the date field is
left empty.

PeoplesoftstartingYEAR: The year is specified in two digits. If the
number represented by these two digits (xx):

- Is greater than or equal to 50, then it is assumed that the year is 19xx.
— Isless than 50, then it is assumed that the year is 20xx.

This specifies a range of 1950 to 2049 for the year.

Copy the following files from the xellerate _home\xellerate\1lib directory
to the WEB-INF\1ib directory:

wlXLSecurityProviders.jar
x1API.jar

x1lAuthentication. jar
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10.

s x1BackOfficeBeans.jar
s x1BackofficeClient.jar
m x1Cache.jar

s x1Crypto.jar

s xlDataObjectBeans.jar
s xlDataObjects.jar

s xlLogger.jar

s x1Utils.jar

s x1VO.jar

Copy the following files from the xellerate _home\xellerate\ext directory
to the WEB-INF\1ib directory:

m oscache.jar
s Jjavagroups-all.jar

Delete the peopleSoftUserMgmt . war file from the temporary directory where
you extracted it, and then use the following command to re-create the file:

jar -cvf peopleSoftUserMgmt.war

You must restart the Oracle Identity Manager server and client before deploying
the re-created WAR file. In addition, before you start the Oracle Identity Manager
server and client, ensure that the peopleSoftApp .war file does not exist in the
application server (JBoss, WebSphere, or WebLogic) deployment directory and in
the xellerate_home\xellerate\webapp directory. If it does, then it must be
deleted.

If you use JBoss and log4j, then logs are produced and archived on a daily basis in
the jboss_server_home_dir/log/server. log directory, where
Jboss_server_home_dir is the parent directory in which JBoss is installed. For
the other application servers, the log file is created and saved in the corresponding
log directories.

Step 5: Importing the Connector Files

To import the connector files into Oracle Identity Manager:

1.
2.
3.

Open the Oracle Identity Manager Administrative and User Console.
Click the Deployment Management link on the left navigation bar.

Click the Import link under Deployment Management. The Deployment Manager
- Import page is displayed, along with a dialog box for locating files.

Locate and open the PSFTBaseConnector .xml file, which is in the
xellerate _home\xlclient directory. The Deployment Manager page is
displayed.

In the Deployment Manager page, click Add File. The File Preview window
showing the details of the selected file is displayed.

Click Next. The Substitution page is displayed.
Click Next. The Confirmation page is displayed.
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10.

11.

12.

13.
14.

Click Next. The Provide IT Resource Instance Data page for the PSFT Base
Server IT resource is displayed.

Specify values for the parameters of the PSFT Base Server. Refer to the table in
the "Defining IT Resources" section for information about the values to be
specified.

Click Next. The Provide IT Resource Instance Data page for a new instance of the
PSFT Base Server is displayed.

Click Skip to specify that you do not want to define another IT resource. The
Confirmation page is displayed.

Click View Selections.

The contents of the XML file are displayed in the Deployment Manager - Import

page. You may see a cross-shaped icon along with some nodes. You must remove
these nodes. To do this, right-click each such node and then select Remove.

Click Import. The connector file is imported into Oracle Identity Manager.

If you plan to use the connector in trusted source reconciliation mode, then
perform the same procedure to import the PSFTBaseXellerateUser.xml file.
This file is in the xellerate_home\xlclient\ directory.

Caution: Only one connector can be configured as a trusted source.
If you import the PSFTBaseXellerateUser.xml file while you
have another trusted source configured, then both connector
reconciliations would stop working.

After you import the connector XML file, proceed to the "Step 6: Configuring
Reconciliation” section on page 2-12.

Defining IT Resources

You must specify values for the PSFT Base Server IT resource parameters listed in
the following table.

IT resource type : PSFTBase

IT resource : PSFT Base Server

Parameter Name Description

Admin User Id of PeopleSoft User Management Server Administrator

Default value: PS

AdminCredentials Password of Administrator

ComponentInterface Component interface used to load user data in PeopleSoft User
Name Management

Default value: USER_PROFILE

ServerName IP address or computer name of the PeopleSoft User

Management server

Sample Value:172.21.100.197

ServerPort Port number at which the PeopleSoft User Management Server is

listening

Default values:9000
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Parameter Name Description

IsDebug Debug feature

The value can be YES or NO. The default value is NO.

IsSecure Specify whether or not SSL feature is enabled

The value can be YES or NO. The dafault value is NO.

Symbolicld Symbolicld is used to find out the Accessld assosiated with the

user profile. This Accessld tells whether ther user has sufficient
privileges on the PeopleSoft database or not.

PS89

After you specify values for these IT resource parameters, go to Step 9 of the procedure
to import connector XML files.

Step 6: Configuring Reconciliation

Configuring reconciliation involves creating scheduled tasks for Lookup Fields and
User reconciliations. To create the schedule tasks:

1.

2
3.
4

10.

11.

Open the Oracle Identity Manager Design Console.
Expand the Xellerate Administration folder.
Select Task Scheduler.

Click Find. The details of the predefined scheduled tasks are displayed on two
different tabs.

Enter a number in the Max Retries field. This number represents the number of
times Oracle Identity Manager should attempt to complete the task before
assigning the ERROR status to the task.

Ensure that the Disabled and Stop Execution check boxes are cleared.

In the Start region, double-click the Start Time field. From the date-time editor
that is displayed, select the date and time at which you want the task to run.

In the Interval region, set the following schedule parameters:

= To set the task to run on a recurring basis, select the Daily, Weekly, Recurring
Intervals, Monthly, or Yearly option.

If you select the Recurring Intervals option, then you must also specify the
time interval at which you want the task to run on a recurring basis.

= To set the task to run only once, select the Once option.

Provide values for the attributes of the scheduled task. Refer to the appropriate
table in the "Specifying Values for the Scheduled Task Attributes" section for
information about the values to be specified.

Click Save. The scheduled task is created. The INACTIVE status is displayed in
the Status field, because the task is not currently running. The task is run at the
date and time that you set in Step 7.

Repeat Step 5 through 10 to create the second scheduled task.
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Specifying Values for the Scheduled Task Attributes

This section provides information about the values to be specified for the following
Scheduled Task.

s User Reconciliation Scheduled Task

= Lookup Fields Reconciliation Scheduled Task

User Reconciliation Scheduled Task

You must specify values for the following attributes of the user reconciliation
scheduled task.

Note: Attribute values are predefined in the connector XML file that
you import. Specify values only for those attributes that you want to
change.

Attribute Name Attribute Value

MultiValueSeperator  ##is the multivalue seperator in the flat file(Reconciliation file)

ServerName Name of the IT resource instance

Default Value: PSFTBase

IsTrusted Specifies the mode of reconciliation, trusted or nontrusted

The value can be Yes or No. The default value is No.

XellerateOrganizatio Default value for the Oracle Identity Manager Organization
n name

This value is used to create the Xellerate User in trusted mode.

FolderPath Folder path of the flat file(. txt file) from where reconciliation
will take place. The Scheduled task will reconcile all the files
present in this folder.

TargetSystem Name of the resource object.
Default Value: PSFTBase

After you specify values for these task attributes, go to Step 10 of the procedure to
create scheduled tasks.

Lookup Fields Reconciliation Scheduled Task

You must specify values for the following attributes of the Lookup Fields
reconciliation scheduled task.

Attribute Name Attribute Value

ServerName Name of the IT resource instance

Default Value: PSFTBase Server
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Attribute Name

Attribute Value

LookupType

The type of data that is being looked up in the target system.

The value can be one of the following:

EmployeeId

LanguageCode

EmailType

CurrencyCode

PermissionList

UserRoles

FilePath

reside.

It will reside on the OIM Server. The Administrator can give any

path here.

Sample Value:
C:\PSFTBase\LookupRecon\EmployeeIds.txt

File Path is the Path where the Reconcilation lookup txt file will

LookupName

The name of the lookup definition configured in OIM.

The value can be one of the following:

Lookup.
Lookup.
Lookup.
Lookup.
Lookup.
Lookup.

PSFTBase
PSFTBase
PSFTBase
PSFTBase
PSFTBase

PSFTBase

.EmployeeId
.LanguageCode
.EmailType
.CurrencyCode
.PermissionList

.Roles

TargetSystem

Default Value: PSFTBase

Name of the resource object

Step 7: Compiling Adapters

The following adapters are imported into Oracle Identity Manager when you import
the connector XML file. You must compile these adapters before you can use them to

provision accounts on the target system.

adpPSFTCREATEUSER

adpPSFTUPDATEUSER

adpPSFTRESETPASSWORD

adpPSFTUNLOCKUSER

adpPSFTLOCKUSER

adpPSFTUPDATEUSEREMPID

adpPSFTADDORDELETEROLE

adpPSFTADDORDELETEEMAIL

To compile adapters by using the Adapter Manager form:

1.
2.

Open the Adapter Manager form.

To compile all the adapters that you import into the current database, select the

Compile All option.
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To compile multiple (but not all) adapters, select the adapters you want to
compile. Then, select the Compile Selected option.

3. Click Start. Oracle Identity Manager compiles the adapters that you specify.
To view detailed information about an adapter:

1. Highlight the adapter in the Adapter Manager form.

2. Double-click the row header of the adapter, or right-click the adapter.

3. Select Launch Adapter from the shortcut menu that is displayed. Details of the
adapter are displayed.

Note: To compile multiple adapters simultaneously, use the Adapter
Manager form. To compile one adapter at a time, use the Adapter
Factory form. Refer to Oracle Identity Manager Tools Reference Guide for
information about how to use these forms.
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Testing the Connector

After you deploy the connector, you must test it to ensure that it functions as expected.

Note: In earlier releases of this guide, the connector was also referred
to as the integration.

This chapter contains the following sections:
s Running Test Cases

= Troubleshooting

Running Test Cases

This section discusses test cases that you can perform by using the troubleshooting
utility.

You can use the troubleshooting utility to identify the cause of problems associated
with connecting to and performing basic operations on the PeopleSoft User
Management server. The following are sample test cases that you can run by using the
troubleshooting utility.

From the JavaTasks directory in which the PSFTBaseProvisioning. jar fileis
present, perform the following tests:

»  Create a PeopleSoft User Management user as follows:

java -jar PSFTBaseProvisioning.jar Create serverName serverPort admin
adminCredentials ciName symbId userId userDescription empId recordname

For example:

java -jar PSFTBaseProvisioning.jar Create 172.19.151.53 9000 PS PS2005
USER_PROFILE PS89 PSFt0101 PSFT0101 KS0001 PERSONAL

= Update a PeopleSoft User Management user as follows:

java -jar PSFTBaseProvisioning.jar update serverName serverPort admin
adminCredentials ciName symbId userId attrName attrValue

In this command, the values for the at trName field can be one of the following:
m USER_DESCRIPTION
s EMAIL_ADDRESS

= EMAILTYPE
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s MULTI_LANGUAGE_CODE
s  LANGUAGE_CODE

s CURRENCY_CODE

For example:

java -jar PSFTBaseProvisioning.jar Update 172.19.101.13 9000 PS PS2005
USER_PROFILE PS89 bb USER_DESCRIPTION TCSDelhi

= Update the employee ID of a PeopleSoft User Management user as follows:

java -jar PSFTBaseProvisioning.jar UpdateUserEmployeeld serverName serverPort
admin adminCredentials ciName symbId userId newEmpId oldEmpId recordname

For example:

java -jar PSFTBaseProvisioning.jar UpdateUserEmployeeId 172.19.101.13 9000 PS
PS2005 USER_PROFILE PS89 bb KS0002 KS0001 PERSONAL_DATA

»  Update password of a PeopleSoft User Management user as follows:

java -jar PSFTBaseProvisioning.jar UpdatePassword serverName serverPort admin
adminCredentials ciName symbId userId password

For example:

java -jar PSFTBaseProvisioning.jar UpdatePassword 172.19.101.13 9000 PS PS2005
USER_PROFILE PS89 bb PERSONALOOL

Troubleshooting

The following table lists solutions to some commonly encountered issues associated
with the PeopleSoft User Management connector.

Problem Description Solution
Oracle Identity Manager cannot = Ensure that the PeopleSoft User Management
establish a connection to the server is running.

PeopleSoft User Management server. = Ensure that Oracle Identity Manager is

running (that is, the database is running).
= Ensure that all adapters have been compiled.

= Examine the Oracle Identity Manager record
(from the IT Resources form)

The Operation Fail message is s Ensure that the values for the attributes do not
displayed on the Administrative of contain delimiter characters (white space).

Oracle Identity Manager s Ensure that the attribute values do not exceed

allowable length.

The Create User adapter is triggered ~ Set the property associated with the user ID
even when the pre-populate adapter  attribute in the process form as required.
is run successfully.
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Known Issues

The following are known issues associated with this release of the connector:

SSL (Secure Socket connections) is not supported.
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